CHAPTER 5

Multimedia
By Scott D. Lipscomb and Kimberly C. Walls

Tell me and I'll forget;
show me and I may remember;
involve me and I'll understand.
—Variously attributed

Section 1: Overview of Multimedia

In recent years, "multimedia" has become one of the most oft-used buzzwords in education, sometimes touted as a potential solution to many education-related challenges. With the arrival of a multitude of tools that facilitate the creation of multimedia materials, creating these engaging instructional materials is well within the reach of any teacher willing to invest the time necessary to learn how to use this software. Yet, these programs continue to get easier and easier to use with each new version. There are a wide range of tools available, varying significantly in their levels of complexity and, correspondingly, the associated learning curve. Some tools, like the presentation software discussed early in this chapter, are largely intuitive in their basic functionality and require very little time to learn the essentials. Others, like the full-featured multimedia authoring programs discussed later, do require a greater investment of time, but the potential payoff can be great. Even these more complex programs, however, require significantly less time to learn than a formal programming language (like C++ or Java), and it is worth emphasizing that the user need not learn how to utilize every capability the program has to offer. In fact, by learning just a handful of the most useful capabilities, instructors can create engaging interactive materials that have great potential for enhancing the learning experience.

Given all of the responsibilities associated with a teaching position, it is certainly reasonable to ask the obvious question: "Why would anyone want to invest the time necessary to learn how to create multimedia instructional materials?" An initial response to this query is that interactive multimedia can make the learning process more fun and engaging for the students. In a more general sense, there is evidence that such engagement results in deeper learning (Skinner, 2005). At a more anecdotal level, this sentiment is expressed beautifully in the oft-quoted statement provided at the beginning of this chapter, variously attributed to Aristotle, to Confucius, as a Chinese proverb, or as a Native American proverb.

This same basic tenet has been a driving force in recent years as more educational programs are devoted to student-centered learning, group learning activities, and problem-based learning contexts. Interactive multimedia provide computer-based technologies that can provide students with many of these same active, engaging learning experiences as these "in person" pedagogical approaches.

Section 2: Categories of Multimedia Software, Representative Examples, and Teaching Applications

Creating Presentations
Presentation programs such as PowerPoint (Mac/Windows) and Keynote (Mac) are used to coordinate the display of text, images, and media on the computer in an interactive manner. A presentation consists of a series of "slides," the term used to describe each screen of content. Many different types of media—including files imported directly from a video camera or captured using image manipulation software (such as Adobe Photoshop or Macromedia Fireworks)—can be incorporated into a presentation. The amount of interactivity incorporated into a presentation can vary widely, as represented here.
A non-interactive presentation that utilizes the timing capabilities of the software to create a presentation that runs automatically (like informational museum kiosks).

A situation that simply requires a mouse click or key press to initiate the display of each element contained on every slide.

A non-linear presentation in which the actions of the user determine the order in which information is presented.

Any combination of the types listed above.

Presentations can also be converted to a series of digital images or saved to a Web-ready format, allowing online access.

Often, presentations created using this software are projected onto a screen to accompany a teacher’s lectures. However, there are many other uses for presentations in the music classroom: teacher-centered activities, group processes, lessons for individualized learning, and performances. Specific examples for each of these types of educational activities are as follows:

TEACHER CENTERED

Display text, play recordings, and show graphics to accompany a lecture, such as introducing a new composition to an ensemble or a new unit theme to a class.

Playing a musical example, using either a digital audio file or audio CD, from within a presentation is easily accomplished: Insert->Movies and Sounds->[select sound source].

Display classroom rules or the daily agenda.

Display and play a teacher-created listening guide.

Graphics or text can be synchronized to a recording, using the timing features of the presentation software: Slide Show->Custom Animation->[select object on slide, then set timing].

Display questions for a timed test incorporating text, graphics, and/or musical examples.

Playback and/or display sight singing or rhythmic dictation exercises.

Convey program or course overview for parent night, open house, etc.

Can be set to run automatically and/or loop continually.

Use in class in lieu of a chalk or whiteboard to interactively take notes on discussion content.

These notes can then be posted to the Web, along with the agenda for the day’s class, homework assignments, and so on.

GROUP

Small groups research a topic, organize their content into a series of slides, then present their report to the class.

Groups record collaborative musical compositions into PowerPoint, allowing you to provide your evaluation of their work.

Groups work together to create an interactive listening guide themselves.

INDIVIDUALIZED LEARNING

Students review materials from missed classes.

Students practice a displayed exercise, recording their practice sessions.

Students create a presentation analyzing a composition they listened to or composed.

PERFORMANCES

Display student artwork during performance.

Provide information about music being performed, including information about the composer, contemporary events, and so on.
Display photos of students participating in activities as an end-of-the-year presentation or yearbook.

Display pre-concert announcements regarding upcoming music department activities such as concerts, trips, summer programs, and so on.

**MICROSOFT POWERPOINT (MAC/WINDOWS)**

By far the most popular presentation software in this category is Microsoft’s PowerPoint ($99.95 upgrade), currently in the 2004 version for Macintosh computers and 2003 version for Windows. The versions leapfrog, such that one platform is always a version ahead of (or behind) the other. PowerPoint can be purchased as a standalone product or as part of the Microsoft Office Suite of applications, including Word (word processor), Excel (spreadsheet), PowerPoint (presentation), and Access, a powerful relational database program available only on the Windows platform.

PowerPoint facilitates the creation of slides containing instructional content with the Slide Layout panel (Fig. 1). To add a slide to your presentation, simply click on the New Slide icon in the toolbar (or use the program menus to choose Insert->New Slide), then select the appropriate type of slide from the Slide Layout panel (Format->Slide Layout). This collection of layouts includes various combinations of titles, bullet points, graphics, charts, and many other media types. You can easily create your own slide layout or add to a slide’s default content by selecting items from the Insert menu. Every object on the slide can be assigned an animated entrance and/or exit from the main content area, using the Custom Animation menu (Slide Show->Custom Animation). In addition, PowerPoint comes with a large selection of predefined templates—found in the Slide Design panel (Format->Slide Design)—that include color schemes, font selection, and slide formatting to ensure that the slides within your presentation maintain a consistent look and feel. As you become more comfortable with the program, you can create your own templates by editing the Slide Master (View->Master->Slide Master). There is even an AutoContent wizard (File->New, then click on From AutoContent wizard in the New Presentation panel) that will provide a basic skeleton of a presentation for you based on the type of presentation you select, though be aware of the fact that you trade a significant amount of control over the design and organizational structure of your presentation for this convenience. We recommend avoiding this latter “convenience” and utilizing the Templates and Slide...
tehncologies far outweigh any potential negative effects, many of which can be minimized, if not eliminated, simply by being aware of the pitfalls. As a result, we recommend being aware of the concerns expressed by Tufte and Norvig, so that you can make more informed decisions in the creation of your own pedagogical materials, resulting in a higher quality of instructional multimedia to enhance learning in your music classroom.

Finally, one must consider the advantages and disadvantages of various hardware setups used to display presentations (or any multimedia products). Both visual and aural aspects of the presentation must be considered. If one student or a small group of students will be viewing a multimedia product, then the computer screen may suffice. One student may listen through a pair of headphones inserted into the headphone jack. An amplified headphone splitter such as the Booster portable audio amplifier and splitter ($29.95) allows up to three students to hear the presentation through headphones. For more than three students, amplified speakers (preferably with a sub-woofer) or a stereo system may be plugged into the computer's headphone jack. A rear converter attached to the video output of the computer can be plugged into a large television to display images for larger groups. Using a television for a presentation can work well for small classes when small visual details are not essential. A data projector can display a larger, more detailed image that is sufficient for detailed viewing by large classes or audiences. Purchasing such converter equipment is less expensive than purchasing a high-quality computer projector, but consider the overall costs, effectiveness, uses of the equipment, and classroom management issues before deciding which option will fulfill your needs and meet your requirements most effectively.

Making Movies and Creating DVDs

Movie software is great for documenting and evaluating performances, especially those involving coordinated movement as in marching band or show choirs. It is also a valuable self-assessment tool, when used to evaluate one's own teaching. Used in a well-designed lesson plan, movie software allows students to understand the role of music in motion picture experience and actually become "movie music composers" themselves. Using sequencing software or digital audio files (discussed in Chapter 2, "Music Production"), students can compose a musical soundtrack for any video sequence. Many of the current sequencing software packages integrate both audio and video capabilities and allow the integration of MIDI and
various types of digital audio, greatly facilitating this creative process. Movie-making software is a specific type of multimedia software for which great strides have been made in recent years. The exponential increase in hard drive storage space available on a typical personal computer (PC)—now measured in gigabytes, rather than megabytes—and similar increases in processor speed—now measured in gigahertz, rather than megahertz—have made basic video capture and amateur movie-making a possibility on most PCs.

Ideas for implementation in the music classroom include the following:

- Record both the audio and video of a performance or rehearsal, then playback for students’ self-assessment.
- Students try using different soundtracks with a film clip or different film clips with a given soundtrack to see the effects on the mood and interpretation of the visual images.
- Students compose their own soundtrack to accompany an existing film or their own original video footage.
- Students record individual performance exams, over which the teacher records (“dubs”) a verbal critique.
- Provide short video clips demonstrating instrumental/vocal techniques or dance routines.
- Any of the ideas from presentation software may be used, integrated into a video context.

With today’s technology, putting together a video tutorial or demonstration is easier than ever, but it still takes time. To determine whether such an effort would be meaningful to you, ask yourself how many times you deliver the same message to your students throughout the year. If you find that you repeat the same information many times, year after year, it may be profitable to document your instruction in a video clip. A brief video clip that explains the basics of instrument maintenance or how to interpret time signatures are good examples.

The discussion of specific software in the following section will be divided into two subsections, based on the complexity and capabilities of the programs. We will begin by introducing three entry-level programs (iMovie, iDVD, and MovieMaker 2), and then we will proceed to a discussion of software with more advanced editing capabilities.

ENTRY-LEVEL SOFTWARE
This most basic level of movie-making software typically incorporates simple drag-and-drop techniques to easily organize a series of various media types (video, sound, still images, and so on) into an impressive, quite professional-looking movie that can be saved as a file on your computer or, optionally, burned to a recordable CD or DVD. In addition to the programs discussed below, Apple’s QuickTime can be used as an inexpensive option for basic video editing. This unique, inexpensive program will be discussed later in the chapter as one of the multimedia authoring software packages.

Apple iMovie and iDVD (Mac)
These two programs come as part of Apple’s amazingly affordable iLife ’05 suite of multimedia software ($49), including iPhoto (graphical image editing), iMovie (movie-making), iDVD (DVD creation), GarageBand (loop-based digital audio and MIDI sequencer), and iMovie (media player). Movie clips, photos, sound files, and other media can be imported into the program, then assembled and rearranged using a “timeline” at the bottom of the program window. With iMovie (Fig. 4), the user can easily create titles for the movie and include numerous built-in transitions and effects to provide an added sense of professionalism to the final product.

FIG. 4: The interface for Apple’s iMovie software
IMovie makes it especially easy to incorporate content from applications in the iLife suite. For instance, a section of an IMovie may feature still images imported from iPhoto with a soundtrack from your iTunes library but originally created with GarageBand. There is one IMovie audio glitch you may encounter that is worth mentioning. The audio soundtrack of longer movies can gradually become out of sync with the video. This happens when the audio bit resolution of the camera that captured the movie is at a different setting than the 16-bit playback used by IMovie. If your camera allows for multiple settings, just choose 16-bit. If not, a workaround is to extract the audio from the video (Advanced—Extract Audio) and lock it in place (Advanced—Lock Audio Clip at Playhead).

Once the movie is created, iDVD can be used to write the complete movie (or a collection of movies) to a recordable DVD. iDVD also makes creation of a DVD menu a snap.

For those who wish to produce even more professional-looking DVD media, there are many products available for this purpose, varying in their level of sophistication, complexity, and price. Some of the many products available are Roxio’s Toast 6 Titanium (Mac; $99.95), Roxio’s Easy Media Creator 7.5 (Windows; $99.95), Apple’s DVD Studio Pro shown in Fig. 5 (Mac; $499), and Sony’s DVD Architect 3 (Windows; $299.95) packaged with Sony’s Vegas 6, professional-grade movie creation software, discussed below.

**FIG. 5: Creating an interactive menu in Apple’s DVD Studio Pro**

**Windows MovieMaker 2**
For the Windows platform, Microsoft has provided a very easy-to-use entry-level piece of movie creation software. MovieMaker 2 (Fig. 6) is included as part of the Windows XP operating system with free upgrades available from Microsoft’s Web site. This software has the same basic capabilities as iMovie for the Mac platform, including a timeline-based assembly method for combining various movies, graphic images, sound files, and other media into a self-contained movie. Once finished, your movie can be saved to your computer’s hard drive, a recordable data CD or DVD, emailed as an attachment, sent to a server via the Internet, or recorded to a tape on a digital video (DV) camera.

**FIG. 6: Adding media to the timeline in Windows Movie Maker**

**MORE ADVANCED EDITING**
When a more advanced video editing system is required, there are many options available. Though significantly more expensive than the entry level software discussed above, two of the more affordable advanced video editing options include Apple’s Final Cut Express (Mac; $299) and Sony’s Vegas Pro 6 (Windows $199.95 or $299.95 packaged with Sony’s DVD Architect 3, a professional-grade program for DVD authoring). Typically, these programs offer the user a significantly enhanced level of creative freedom in the movie-making process and include higher precision editing tools, more complex transitions, more advanced effects, improved sound handling capabilities (e.g., multichannel audio, 5.1 surround sound mixdown, and so on), improved rendering, increased compatibility with more media types, to name just a few of the many enhancements.

**Final Cut Express (Mac)**
Final Cut Express is a limited version of Apple’s professional-level program, Final Cut Pro 5 (Mac; $999), but it is a full-featured video editing package that should provide educators with all the power they need. In addition to the enhanced capabilities available in these higher-level software packages, the user also has a great deal of flexibility to alter the interface by showing or hiding various windows or panels, depending upon what task needs to be completed at any given time. For example, in Fig. 7 you will notice the
timeline at the bottom of the Final Cut Express window. In addition, I have chosen to reveal a list of effects, such as (from left to right) the Cross Zoom panel (for adjusting the effect parameters) and a preview panel that displays the resulting video at the current point of the playback head (represented by the vertical line that scrolls horizontally across the timeline as the movie plays back).

**FIG. 7: Editing video in Apple's Final Cut Pro**

Final Cut Express and other advanced video editing programs provide the user greater flexibility, a more customizable interface, and more choices of transitions and effects. One of the primary reasons for stepping up to this next level of software is the capability to handle a greater number of tracks (both audio and video). While some of the entry level software is quite limited in their ability to handle anything beyond basic two channel audio and a limited number of video tracks, with Final Cut Express and similar software, the designer can utilize multiple audio and video tracks, creating a complex multimedia experience. Advanced video editing software also typically affords compatibility with a greater number of file types for both importing into a project and exporting the finished project, using any one of a growing number of compression schemes to reduce the file size without sacrificing an unacceptable amount of the image or sound quality. Apple's Soundtrack Pro ($99) is an impressive audio editor that shares a highly integrated relationship with Final Cut Express, allowing the user to move back and forth between the two applications for quick and easy audio editing or for recording new audio material for a given visual sequence.

**FIG. 8: Video editing using Sony's Vegas Pro**

Another advanced video editing option—formerly a cross-platform solution, but now available only on the Windows platform—is Adobe's Premiere Pro 1.5 ($219.95; Premiere Elements, a reduced package, is available for only $69.95), offering many of the same functions as Vegas Pro, but including tight integration with other Adobe software such as Photoshop (graphic image editor), Audition (digital audio editor), After Effects (motion graphics and visual effects), and Encore (DVD authoring).

**Capturing Digital Images**

Digital image capturing software provides a method for the creation of image files that can be integrated easily into a presentation, a movie, or in printed materials (e.g., flyer or newsletter). Many photo editing and graphics programs include a "slide show mode," allowing the user to display a sequence of images, often even providing an easy method for adding a musical soundtrack to the slideshow. Some of these programs also provide a way to export a sequence of images as a movie for playback using one of the
popular media players (e.g., QuickTime, Windows Media Player, RealPlayer). Though there are many ways to capture images, two of
the most commonly used methods will be discussed below: scan-
ing images and importing images from a digital camera or digital
video camera.

SCANNING
When you purchase a flatbed scanner, you should receive a CD-
ROM containing software compatible with the operating system
of your computer. In order to get full functionality from your scanner,
you will need to install this software. Typically, two sets of func-
tionality will be included with this installation. There will likely
be a stand-alone program that allows you to scan text documents,
graphic images, or a combination of the two into an appropriate
format. Some of the more advanced software even includes optical
character recognition (OCR) capability so that the document text
is converted from a graphic image into text format, reducing the
file size dramatically and allowing the text to be edited in a word
processing application such as Word or AppleWorks. In addition to
providing the standalone software, most scanners will also include
drivers (utility programs that remain largely invisible to the user)
that allow your scanner to be accessed by programs that have the
capability to integrate scanned images into their functionality.
Two of the most prominent types of programs that benefit from
such connectivity include graphic editing software (e.g., Adobe
Photoshop, Macromedia Fireworks) and music notation software
(MakeMusic Finale, Sibelius). Both of these types of programs can
import images either for the purpose of editing the image content
or for converting the graphic symbols into music notation, a very
powerful capability indeed for the music teacher. Another promi-
nent program that may include access to scanning drivers is Adobe
Acrobat, which allows documents to be saved as PDF files (portable
document format) for Internet delivery.

Software Packaged with Scanners
The software that comes with a Hewlett-Packard ScanJet 3970,
a moderately priced, consumer-level scanner owned by one of
the present authors, allows the user to select one of the follow-
ing options: scan picture, scan document (can include text and
images), or make photocopies of the scanned document (Fig. 9).
Once the appropriate document type has been selected, it is pos-
sible to set a number of properties that will determine the quality
of the scanned file and how large the resulting image will be. The
two most important settings are the resolution and number of colors.

The resolution setting determines how many dots per inch (dpi)
will be captured. The higher the resolution, the clearer and more
accurate the captured image will appear. Higher resolutions also
result in significantly larger file sizes. If you plan to use your images
for a high-quality print, you will probably want to set the resolu-
tion to 600 dpi (or higher). If, however, you intend to use the image
only on the World Wide Web (WWW) where it will be viewed on a
computer screen, there is no reason to set the resolution any higher
than 72 dpi. This will keep your file sizes much smaller, resulting
in significantly less "waiting time" for visitors to your Web site.
Similarly, the number of colors can be set to monochrome (black
and white only), grayscale, or any of a number of predefined color
settings, including 256 colors (8-bit), 65 thousand colors (16-bit),
and millions of colors (24-bit). Once again, the purpose for which
you are scanning should determine your needs. If you want a high
quality color print, you may want to go with the highest 24-bit
(millions of colors) setting. If the print copy will be black and
white, you can reduce the file size significantly by using a grayscale
setting instead. Likewise, if your image will be viewed solely via the
WWW, you will ensure consistency between viewers using different
browsers on varying operating systems by selecting the 8-bit
(256 color) Web palette setting.

Typically, the scanning software requires only a very few highly
intuitive steps:

1. Start the program.
2. Insert the document or picture face down on the glass of the
   scanner.
3. Choose the appropriate settings as described above.
4. Initiate the scanning process.

5. Provide a file name for the scanned document or image file.

Most scanning applications allow you to scan multiple pages before saving them to a file on your hard drive. In addition, it is often possible to save files in any number of formats, including as a graphic image (TIFF, JPG, GIF), text only, and rich text format (RTF), the latter of which can be opened and edited directly in a word processor. PNG graphic images are more commonly being incorporated into Web pages, though the level of cross-platform and cross-browser compatibility inherent in JPG and GIF images for online use remains unexcelled at present. Another highly compatible means of transferring graphic images between applications is the Adobe Acrobat (PDF) format.

Using Scanned Images in Other Software Applications

To scan an image into Photoshop, after successfully installing the driver from your scanner's CD-ROM, one need only select the appropriate device from the Import submenus (File→Import→[select device]; see Fig. 10). If you do not see your scanner listed here, you will need to reinstall the driver or call technical support for assistance. Once you have selected your scanner, a window will open that looks almost identical to the standalone version of your scanner software, allowing you to perform the exact same steps enumerated above to capture the image. Once the scanning is complete, however, the scanned image will appear as a new document in Photoshop, where you can save it as a Photoshop document (PSD), export in a Web-ready format (File→Save for Web), or edit the image.

FIG. 10: Importing a scanned image directly into Photoshop

FIG. 11: Scanning music notation into Sibelius using PhotoScore

CAMERAS

Another method for getting images from a remote source to your computer is to use a digital camera or video camera to capture the images, then transfer them to the computer hard drive. The most common means of transferring files is via a USB 2.0 or FireWire port, since the file size can be quite large and these transfer protocols are fast enough to withstand where a parallel or USB 1.0 port would take significantly longer. Even faster data transfer rates can be achieved for transferring images from a digital camera by purchasing an adapter that allows you to remove the flash memory card from the camera and insert it directly into the computer.

The most important specification to identify when purchasing a camera is the number of pixels used when storing each image, typically reported in terms of megapixels (one megapixel equals approximately one million pixels). At the time of publication, 5.1 megapixel cameras were the standard, while 8 megapixel cameras...
were considered state-of-the-art. In many contexts, depending on the intended use for your pictures—especially if they will be viewed only via the Internet—a lower resolution (3.2 or even 2.0 megapixels) might suffice. Also, you will want to be aware of the format in which your images will be saved, since most cameras compress the images immediately upon capture, sacrificing some of the image quality in order to economically utilize the finite space available on the memory stick or flash drive.

Digital cameras and video cameras that are able to transfer data to a computer typically come with the software required to complete this task. Because each camera manufacturer provides software that varies significantly, we will focus on the basic steps required to capture the images and then to transfer them to your computer. You should, of course, carefully read the documentation that comes with your own camera and/or software to ensure that you are doing it correctly for your specific equipment setup.

The basic steps involved are as follows:

- Capture your still images (digital camera) or motion pictures (video camera).
- With your computer turned on, connect your camera to the USB or FireWire port on your computer, then turn the camera on.
- In many instances this will automatically initiate the data transfer; if not, you will need to refer to your owner’s manual to determine the appropriate steps to be taken.
- Make sure that you know where the pictures will be saved on your computer, a property that is typically set in the configuration settings of the software that came with the camera.
- Optionally, you can edit any of the images using a graphic image editor like Photoshop, Fireworks, or Paint Shop Pro.
- Transfer images to PhotoCD, incorporate them into a Web site, an audio-visual presentation (PowerPoint or Keynote), or a multimedia movie (iMovie or MovieMaker), or store them on your computer hard drive for use at a later time.

Like the incorporation of scanned images, digital cameras and video cameras are becoming ever more user-friendly and their products easier to integrate into multimedia contexts. This is one area in which you should simply take the first step by diving in head first, since there is little chance of negative impact. After all, students love to see pictures of themselves, and you can take one step toward getting them more involved in the learning experience by recording their efforts for posterity, gaining appropriate permissions for using such images, of course.

Some uses for digital images include the following:

- Scanning a notation excerpt to be used in an educational handout
- Scanning a notation excerpt to be used in a presentation
- Collecting digital photos to document an activity or process
- Adding photos to a school music department Web site
- Photographs of unusual instruments (can be supplemented with digital audio files of performances on the instrument)
- Photos for animated listening guides (presentation or movie)
- Photos to generate ideas for compositional activities (presentation or movie)
- Prepare a brief movie clip to incorporate in a presentation or Web page

The World Wide Web

It is possible to place almost any of the media you create using multimedia software on the Internet for access via the World Wide Web. When doing so, however, it is very important that you keep in mind issues related to U.S. copyright law and that you always remain vigilant to potential violations regarding the privacy of your students and their work.

Most word processing software allows the user to easily save files in a Web-ready format. In Microsoft Word, for example, you can open any document. Select File→Save as Web Page, save the file with an "html" or "htm" extension, and upload the converted document to your server for immediate online access by your
students, parents, and/or other teachers. While this may be the easiest and most expedient way for a novice to create a Web page, it affords the least amount of control over how the document will appear and function online. In order to gain such control, one must use one of the many Web authoring software packages that are now available. A couple of the most popular are discussed below.

**WEAVING WEB PAGES**

Web page authoring tools allow teachers and students to create Web pages that make multimedia projects accessible to anyone around the globe with an Internet connection. Web page software works best for creating pages that display static information such as text and still graphics, video and synchronized media such as movies or presentations are typically incorporated into Web pages as links to Web-compatible multimedia files. Users may need to download plug-in software to access audio, movies, or presentations, depending on the format of the media. Web pages do not provide the designer with the same high degree of control over appearance and timing of media as presentation, audio, or video processing software, but they do have the benefit of distributing that information to anybody on the Web who has an Internet connection in a format that is, in most cases, cross-platform and cross-browser compatible. Be aware that you may have students who do not have access to the Web from home, so be careful about requiring home assignments utilizing the Web.

Web pages are often used as primary communication between the music program and the program's constituents outside of class meeting time. For example, calendars and informational announcements for parents and home practice materials for students can be disseminated via the Internet. Web pages may also be used to organize research and reference material so that students can learn more about topics introduced in music class. Teachers may create course Web pages that include syllabus, assignments (including downloadable worksheets, audio examples, and so on), and hyperlinks to valuable information resources. Student compositions and performances may also be archived to the Web, but make certain you have the students' and publishing companies' permissions to do so.

**Mozilla Composer:**

As a free component of the Mozilla browser, Composer provides a great way to start creating your own Web pages. Simply download the Mozilla Suite (free). In addition to Composer (the HTML editor for creating Web pages), this suite of programs includes the Mozilla Navigator (an Internet browser), an e-mail and newsgroup program, and chat capabilities. Once installed, you simply select the desired program from the Windows menu. For our present purposes, we will select Composer, an amazingly capable HTML editor, given the fact that it is provided to you at no charge. HTML is an acronym for hyper-text markup language, the code system used by Internet browsers to format the content of Web documents.

Like most HTML editors, Composer provides a WYSIWYG (pronounced: "wixie-swig") interface, which stands for "what you see is what you get." Like Word, Word Perfect, and other present-day word processing software, you see exactly what your final document will look like as you type (Fig. 12), rather than entering HTML tags like This text is **bold** to make the text surrounded by the opening (**strong**) and closing (**strong**) tags appear in boldface type. Instead, like in a word processor, you simply type your text, select the text to which you wish to apply formatting, then click on the appropriate formatting button on the toolbar (the "B" in this case) to create boldface type. Think of Composer as a simple word processor for creating Web pages. You can also apply paragraph formatting (indent, body text, etc.) by selecting the desired format from the drop-down box on the left side of the toolbar. You can show and hide the various tools by selecting View→Show/Hide→[select or deselect toolbar]. In addition to paragraph formatting, the Format toolbar gives you one-click access to the text color, font size, bold, italic, underline, paragraph indent, paragraph alignment (left, center, right, or justified), and some more advanced capabilities. The Composition toolbar provides direct access to opening, saving, and creating new HTML files. It also provides buttons for adding hyperlinks, images, and tables to your page and a spell checker to minimize the chance that typographical errors will be retained on your Web pages.

**FIG. 12: Creating Web pages using Mozilla’s Composer**
Though the WYSIWYG interface is intended to "protect" the Web designer from having to work directly with the underlying HTML code, it is possible to view that code using the Edit Mode toolbar. Pursing the content of the Code window after using the WYSIWYG editor to create a Web page is a marvelous way to learn how to work with HTML "as you go," rather than having to learn all—or even a significant amount—of the codes before you begin the process of creating Web pages.

**Macromedia Dreamweaver MX 2004 (Mac/Windows)**

Dreamweaver MX 2004 ($95) is a full-featured HTML editor that has capabilities well beyond those provided by basic programs like Composer. All of the capabilities described above are possible in Dreamweaver, though the toolbar system for this program provides dozens of extra features that are accessible to the designer by default and can be readily personalized to suit the individual's preferences and needs. Dreamweaver allows you to work in Design mode (WYSIWYG), Code mode (HTML code), or Split mode, allowing the designer to see both views simultaneously. In addition, the Properties window allows direct access to design formatting relevant to any selected object in the document (Fig. 13).

**FIG. 13: Using Macromedia's Dreamweaver to create a Web page.**

Perhaps the most powerful aspect of Dreamweaver is its site management capability. Beyond its ability to provide a WYSIWYG interface for the creation of simple to extremely complex Web pages, Dreamweaver is an invaluable tool for the maintenance and management of a Web site. Though utilizing this capability does require an additional step—defining a "Site" for each of your Web sites—once this process is completed, the program will assist mightily with the tasks required when maintaining a Web site. For example, the Synchronize command (select Site→Synchronize from the File window's context menu) allows a method for updating all files that have changed since the last time files were uploaded to the server. Once the user has connected to the Internet and initiated the Synchronize process, Dreamweaver compares all files within the site folder on your local computer to all files on the server and provides a list of files that need to be uploaded (or downloaded) to ensure that all files on the Internet server are the newest version. With a single click, Dreamweaver will update all files. In addition, the Check Links Sitewide command (Site→Check Links Sitewide) will search every file in your Web site and report to you the number of broken links (links to files that do not exist), external links (links to pages outside of your Web site), and orphaned files (files to which no files within the site are linked).

Any of the teaching/learning ideas from presentations can be used with Web page authoring tools, just keep in mind that audio/visual synchronization is not feasible with basic HTML Web page creation. In order to accomplish such high-level integration of multiple media types for presentation online, multimedia authoring software provides a solution and will be discussed in the coming pages.

**COURSE MANAGEMENT SOFTWARE**

Course management software offers many of the same possibilities as Web page authoring software regarding distributing media, presentations, movies, and Web pages. One primary distinction, a definite advantage when copyrighted materials serve an important educational purpose, is that the course management Web site is typically password-protected. This means that only students enrolled in your course(s) have access to the site. As a result, you may be able to share recordings, scores, and other published material that the school has purchased for this purpose. Though each teacher should confirm the local school and district policies regarding such matters, placing materials on a password-protected server significantly strengthens the "fair use" argument for sharing copyrighted materials with students for educational purposes.

Course management software adds features to Web sites that can enhance the learning experience. Those features include internal e-mail, discussion forums (sometimes called bulletin boards), chat, audio conferencing, calendars, contact information, assignment uploading, an online gradebook for posting student grades, and quizzes that can be graded and entered into the online gradebook automatically. Because such programs are intended to allow access to course materials online, course management software is
typically cross-platform and cross-browser compatible. Two of the most commonly used course management systems are Blackboard and WebCT. Because the present authors are most familiar with the former, we will provide details about this software package. However, most of these same capabilities are available in WebCT and other similar course management systems. One particularly easy-to-use course management solution, free to all educators and available online, is TeacherWeb. It is also worthy of note that many of the major education publishers are providing pre-packaged course content that instructors can download and customize for use in their own classes from within one of the commercial course management software systems.

Some of the ways music teachers have utilized course management software include the following:

- Posting recordings for students to listen to at home
- Encouraging further dialogue about music-related topics through bulletin board postings
- Having students turn in assignments consisting of typed responses or audio recordings of their performance
- Collecting student input via anonymous surveys
- Administering quizzes (graded or ungraded) to review material covered in class or online

Blackboard

Within the context of a chapter such as the present one, it would be impossible to cover all of the many possibilities of a program like Blackboard. As a result, we shall focus on those aspects of the program that have proven most useful in our own classes. The general purpose of "course management" is to provide easy access to a variety of course-related materials and create course areas online where students can interact with one another about the topic of study outside of the classroom in a variety of ways.

Blackboard allows the instructor an easy way to create Web-ready content, using the Visual Text Box Editor, a simple WYSIWYG interface. Using QuickEdit, the instructor can quickly switch between the instructor view and student view of the course content. The program also comes with a Syllabus Builder that facilitates the process of creating an online syllabus, either by uploading an existing syllabus or producing a brand new syllabus using the built-in syllabus creation functionality. Instructors can create sequenced lessons using Blackboard's Learning Units and can determine whether students can navigate through the material at will or if they must proceed through the lessons in a predetermined sequential order.

![FIG. 14: Using the Discussion Board component of Blackboard](image)

Discussion boards, an important component of most course management systems, provide a marvelous method for taking topical discussions outside of the classroom. The instructor can create multiple forums, typically organized around a specific topic, in the Discussion Board area for the purpose of allowing (or requiring) students to contribute to an ongoing discussion on any or all of the delineated topics (Fig. 14). Unlike chat rooms, discussion boards are an asynchronous, nested form of communication. The term "asynchronous" refers to the fact that participants need not be logged on to the system at the same time to carry on a dialogue. Rather, one person can submit a contribution (called a "post") to the discussion board, and it will be seen by other members of the class the next time they log on to Blackboard and access the Discussion Board area. The term "nested" refers to the manner in which a series of posts are organized visually on the computer screen. When one participant contributes a new post (called a "thread") to the discussion, other participants have the choice of either replying to that post or creating an original thread of discussion on their own. Posts that are replies to other student contributions are nested (that is, indented) underneath the original post to which the message was intended as a response. This provides a very clear visual representation of the virtual conversation in which the students are participating and greatly facilitates the
ability to follow a common thread of dialogue from its initial post through all topic-related replies.

Blackboard also facilitates group activities with the Groups tool, allowing the instructor to create multiple subgroups of students. Each group can be assigned to its own file exchange area (for collaboration on group projects), discussion board, virtual classroom (chat), and group e-mail. Instructors can create Assignment items within Blackboard that allow students to submit their assignment electronically. When using this method, the assignments for an entire class can be downloaded simultaneously by the instructor. An online Gradebook, with calculation functionality built-in, allows the instructor to maintain student grades in a safe location, where each student has direct access to their own grades—but no one else’s—for all graded assignments and quizzes. The Gradebook supports grading scales, grade weighting, and item analysis.

As these courseware management systems continue to mature, more and more third-party tools are being created to assist teachers in the process of creating educational online materials. Many of these products can be found by perusing the Blackboard and WebCT sites. Two particularly useful additions are Respondus (for the creation and management of exams) and StudyMate (for the creation of interactive activities and games).

**FTP CLIENTS**

Once you have created your multimedia materials, you can begin integrating them into your music classroom and instruction. In addition to making these interactive learning materials available on computers located in the school, many of the programs mentioned in this chapter allow you to create Web-ready versions of the software that can be accessed via the Internet. However, in order to allow students access to these materials online, you must upload the Web-compatible files to a server. If you do not own Dreamweaver or simply have not yet learned how to use its site management capabilities, you will need to use a utility or program to upload the files to the Internet, using file transfer protocol (FTP). The programs mentioned in this section (and many others) provide the capability of transferring files from your local computer (the computer you used to create the materials) to a remote server (a computer typically located at a different location) that is connected to the World Wide Web.

Because the primary function of these programs is simply to transfer files from one computer to another for the purpose of making them available via the World Wide Web, we will make no specific suggestions for integration of this software into the classroom. Instead, these programs should be considered absolutely essential tools, required to place your files on the Internet. The most common FTP clients are platform-specific, so we will provide a brief introduction to one of the most used programs for each of the two major platforms, Macintosh and Windows.

**Fetch 5 (Mac)**

Fetch 5 (free for educators) is a Macintosh-based program for transferring files using FTP. The interface for this program is extremely simple, providing only the most essential options (Fig. 15). When the program starts, the user connects to the desired server by entering the appropriate URL, username, and password or using a previously saved "shortcut." The program allows users to transfer files from a remote server to their local computer (download) by clicking on the Get button on the toolbar and selecting the file(s) to transfer. Similarly, in order to upload files (i.e., transfer files from the local computer to a remote server), the user simply clicks on the Put button on the toolbar and selects the files to be transferred. Alternatively, users can simply drag and drop files from their hard drive onto icons representing folders on the server.

**AbsoluteFTP (Windows)**

VanDyke Software's AbsoluteFTP ($29.95) is a Windows-based program that facilitates the process of transferring files in much the same way that Fetch accomplishes the task on the Mac platform. This software incorporates a very familiar design, allowing the user to copy files to or from the server by dragging and dropping them from one window to another... exactly the same method one uses to copy files between folders on the local hard drive using Windows Explorer (Fig. 16). The only difference is that the user must log on to the server with a username and password before files can be copied or moved. Like Fetch,
MULTIMEDIA AUTHORING TOOLS
Multimedia authoring tools constitute one of the most advanced types of software discussed in this chapter, allowing the creation of truly interactive and engaging instructional materials. Many interactive programs—commercial, shareware, and freeware—have been created to fulfill a variety of specific needs for music teachers. For example, the creation of interactive listening guides has been greatly facilitated by programs like ECS Media’s Timesketch Editor ($99.95) and Scott Lipscumb and Marc Jacoby’s BubbleMachine (free download; Fig. 17). The authoring tools described in the following paragraphs, however, provide the flexibility necessary to create interactive multimedia educational materials individually suited to a specific task-her’s needs. Like all programs, of course, one does not have to know and understand all of the capabilities available before making effective use of a subset of these functions. In fact, both of the cross-platform programs discussed below offer the user a streamlined method for the creation of interactive multimedia. It is possible to learn the basics that will allow you to get up and running in a matter of hours. For those willing to take the time to learn how to utilize some of the more complex capabilities, however, these programs offer an infinite set of possibilities.

FIG. 17: An interactive listening guide created with BubbleMachine.
for free download from the Apple Web site. In order to create and/or edit your own multimedia, however, you must purchase the "Pro" version of the software. It is certainly an economical option since, at $29.99, this program offers some impressive capabilities. QuickTime can be used as a basic file conversion utility to convert one type of audio, video, or audio-video file to another type. The list of compatible file formats is simply too extensive to include in this chapter, but it includes all of the most frequently used types, and more. One of the most useful conversion possibilities available is the conversion from MIDI files to digital audio (WAV, AIFF, or MP3). Though the size of the resulting file will be much larger than the original MIDI file, the digital audio file can be easily burned to an audio CD. QuickTime movies can include sound (MIDI or digital audio), images, video, animation, text, or any combination of compatible media types (Fig. 18). The program also includes remarkable compression technology, allowing the user to determine the appropriate compromise between sound and image quality and file size.

FIG. 18: An interactive listening guide created in Apple's QuickTime Pro.

Beyond basic file conversion, QuickTime affords the intermediate-to-advanced user some powerful editing capabilities that, with some effort, can result in impressively interactive instructional media. This program provides an economical alternative to the more expensive options discussed below and the video editing software discussed in a preceding section, though its simplistic interface makes creating more complex multimedia a bit difficult. Many programs, such as Macromedia Flash and Adobe GoLive or LiveMotion, provide an option to save files in QuickTime format. Though this requires purchase of one of these more expensive programs, the creation of complex multimedia is made substantially easier and the process is significantly streamlined. Even PowerPoint and Keynote allow you to export the slides in a presentation as a series of images that can then be imported into QuickTime where an audio soundtrack can be added. QuickTime can also import any set of digital photos, such as a folder of family or classroom photos, or a photo album from iPhoto. That said, investing a bit of effort toward learning how to use the QuickTime interface will result in substantial payoffs without significantly taxing your technology budget.

Macromedia Flash (Mac/Windows)

Macromedia Flash MX 2004 provides an authoring environment for the creation of truly interactive multimedia materials. The free browser plug-in and player available from the company's Web site have established a near-ubiquitous presence on the Internet—over 95 percent of the computers used to surf the Internet have the plug-in installed, making this program one of the most reliable ways to ensure that your users will be able to utilize your interactive instructional materials to their fullest extent. Flash provides a marvelous balance between user-friendliness and complexity (Fig. 19). It is possible to learn the program's most basic capabilities and put these to work almost immediately in the creation of interactive instructional materials. The inclusion of "Behaviors" in the most recent versions of the program greatly facilitate the integration of interactivity and the ease with which more complex movies can be created. For those willing to spend the extra time to learn ActionScript, the scripting language that is part of Flash, the program's potential is almost limitless. Though there are still some multimedia tasks that Macromedia Director accomplishes better—with its Lingo scripting language and Shockwave movie creation for online access—in recent years, Flash has become the program of choice for many Web developers. One obvious reason is the cost: academic pricing for Flash is less than $100, while Director still costs about $500. One area in which Director retains a distinct advantage over Flash is in the handling of MIDI—Flash does not include MIDI capability, while Director can be used to create some very impressive MIDI-based materials that even incorporate music notation. In order to do so, however, a third-party package (such as Sibelius' SequenzX [$249]) is required.

Though it does not allow the direct import of MIDI files, Flash offers many other attractive and useful capabilities. Its tight integration with other Macromedia products in the Studio MX 2004 suite ($195; including Flash, Dreamweaver, Fireworks, and FreeHand) is certainly an advantage. Flash allows users to import graphic images, video, sound files, and many other types of media created in other programs or downloaded from the Internet. Many types of objects (e.g., text, ovals, rectangles, lines, customized
gradients, etc.) can be created directly in Flash, using the Tool palette. These basic shapes and objects can be combined to create professional-looking graphics, buttons, or other objects for use in your own animations. In addition, Flash comes with several common libraries to provide many ready-to-use objects. The Buttons library contains an impressive array of buttons, sliders, knobs, faders, and other useful objects that can be readily included in your movies. The Learning Interactions library contains templates—including complex interactive capabilities—for creating various types of quiz forms: true-false, multiple choice, fill in the blank, drag-and-drop, and others. In addition, the program comes with a remarkable set of components with built-in functionality. Some of the most commonly-used components—Macromedia's built-in, interactive objects—include the checkbox, radio button, progress bar, list box, combo box, text input, and many others. The professional version of Flash (costs $50 more than the standard version) also provides advanced features for creating forms, database connectivity, high-quality video, advanced components (media playback, data grid, calendar, menu, and more), and many other impressive capabilities.

FIG. 19: Creating an interactive music mixer in Macromedia's Flash MX 2004.

Like many Macromedia programs, Flash uses a timeline metaphor to facilitate the creation of animations. This allows complex animations to be created without necessitating the frame-by-frame creation of each individual image. Instead, the user marks important locations (called "keyframes") along the Timeline and sets the desired location of each object in the movie at this point in time. Flash then automatically calculates the appropriate location for each object in every intervening frame, a process known as "tweening." Because Flash utilizes vector graphics instead of bitmaps (or raster graphics), the resulting files are much smaller and take less time for online visitors to download. The context-sensitive Properties window allows users direct access to the most common attributes of any object selected in the work area (or Stage). Other panels (accessible from the Windows menu) allow the user to set the alignment of objects on the Stage, transform and skew objects, mix colors, use pre-made components, view all objects in the present movie, along with many other possibilities.

For those who wish to move to more advanced levels of interactivity, Flash provides a powerful programming language called ActionScript, providing many of the same capabilities that were previously only the purview of much more complex and difficult to learn programs like Java and C++. With the arrival of ActionScript 2.0 (included with Flash MX 2004), object-oriented programming is possible within Flash, providing a much higher level of control and enhanced potential for users willing to invest the time to learn these more advanced techniques. There are many helpful resources—some of which are listed in the "Resources" section at the end of this chapter—that will assist you in learning how to use this program to meet your instructional objectives and enhance the learning experience for your students.

**ELECTRONIC PORTFOLIOS**

In recent years, "electronic portfolio" (or "digital portfolio") has become another significant buzzword in the educational community. Using some or all of the technologies discussed in this chapter and elsewhere in the present text, students and teachers can document their academic accomplishments and development processes for dissemination to prospective employers, educators, colleagues, or other individuals with a level of ease and compatibility never before possible. Portfolios provide an opportunity to document intellectual growth, scholarly maturation, and—specific to our current objective—acquisition of technology-related skills. In addition, a portfolio typically includes foundational content, including a personal statement, teaching philosophy, specific skill sets, and evidence of scholarly work, lesson plans, and teaching ability. Bauer and Doty (2002) distinguish two different types of portfolios: the developmental portfolio and the showcase portfolio.

The [purpose of the] developmental portfolio is to document growth across time and thus contains a multitude of materials showing various stages of progress in a person's development. A showcase portfolio is amassed for the purpose of showing the highest level of attainment as well as the professional competence of a person. (p. 3)
Typically, the highly organized structure of a portfolio document is based upon a set of goals or standards related to specific proficiencies considered desirable within the profession or field of study. The National Standards for Music Education can be used to provide a common framework for the organization of music-related portfolio materials.

The electronic portfolio retains several significant advantages over its predecessor, the hardcopy portfolio. The electronic version can be updated continuously, so that an individual's most recent accomplishments are always included. Every type of multimedia discussed in this chapter (video, animation, interactive instructional materials, etc.) can be readily incorporated into an electronic portfolio and provides the viewer with an opportunity to see these elements exactly in the manner they were intended to be used, rather than looking at still images captured for the purpose of inclusion in a hardcopy document. One of the most useful approaches is to create a Web-ready electronic portfolio that can be made available for viewing via the Internet. This allows the student or teacher to disseminate the URL (Web address) to interested individuals, so that every time the information is accessed, the most up-to-date version of the portfolio is available. Alternatively, the current set of data files (HTML, media, and other documents) can be burned onto a recordable CD or DVD and sent for review. Experience has shown that, when the latter method is chosen, it is always wise to include a hyperlink to the URL where the most current version of the portfolio can be found. One of the greatest advantages of the portfolio approach to assessment is that the student or teacher plays an active role in this process, constantly witnessing their own growth and acquisition of new skills.

**FILE TYPE CONVERSION**

Throughout this chapter we have referred to many multimedia file types and alluded to the desirability of saving or converting certain content to one file type or another depending on its intended use. For instance, a graphic image originally saved as a high-resolution TIFF may be converted to a compressed (smaller) JPEG file format before incorporating it into a Web page or PowerPoint presentation. Similarly, a teacher may want to convert a recording of a student performance saved as CD-quality audio (16-bit, stereo, 44.1 kHz sample rate, and saved in either AIFF or WAV format) to a smaller, compressed format such as MP3 for storage in a digital portfolio or to e-mail to a parent.

There are many useful programs to help you convert digital audio, image, and video files from one file format to another. The free program, iMovie, can import most sound formats, as well as standard MIDI files and can convert to AIFF, MP3, and WAV formats. Preview (part of Mac OS X) and Windows Picture and Fax Viewer (part of Windows XP) can both be used to view many image file types and to convert from one format to another. As mentioned previously, QuickTime Pro can be used to convert between numerous image and audio file types and the program also allows for the creation of movies that incorporate multiple media types. These movies can then be exported in a variety of useful multimedia formats, containing both sound and image (AVI, MPEG-4, QuickTime movie, and so on).

**Conclusion**

The various technologies presented in this chapter provide an almost infinite amount of potential to the teacher willing to invest even a small amount of energy into learning at least the basic capabilities of one or more of these programs. In addition, throughout the chapter, we have attempted to suggest effective ways in which these engaging—often interactive—materials can be integrated into the music classroom. These suggestions, of course, merely scratch the surface of the potential inherent in these technologies and their practical application. We encourage you to use your own creativity to determine novel and innovative ways of integration that best suit your own teaching style. Once you have had the opportunity to discover successful methods that enhance the educational experience in your classroom, please take time to share these experiences with other teachers so that they too can benefit from your efforts. Professional conferences, both local and national, provide opportunities for disseminating this information in a manner that both earns you well-deserved recognition for your effort and benefits other colleagues who share your interest in music technology. The annual conferences of the Technology Institute for Music Educators (T.I.M.E. K-12), the Association for Technology in Music Instruction (ATMI), higher education), and the National Symposium for Music Instruction Technology (NSMIK; K-12) provide excellent opportunities to communicate your own experiences, learn from the experiences of others, and network with other music educators who are interested in pedagogically meaningful technology integration.
Section 3: Resources

Books


Internet Resources

MUSIC TECHNOLOGY ORGANIZATIONS
Association for Technology in Music Instruction (http://atmironline.org)—includes instructions for subscribing to the ATM! (listerv)
Technology Guide for Music Educators

University of Virginia's Center for Technology and Teacher Education (http://www.education.virginia.edu/class/edla/589-079/sample.html)

Helen Barret's portfolio examples (University of Alaska) (http://helenbarre.com/All/samples.html)

RESOURCES FOR INFORMATION ABOUT U.S. COPYRIGHT LAW
www.copyright.gov/
www.royaltyfree.com/copyrightlaw/copyrightlaw.html
www.ucar.edu/copyright

ACADEMIC PRICING FOR SOFTWARE
Academic Superstore (www.academicsuperstore.com/)
Creation Suite (www.creation.com/)
Software Express (www.swexpress.com/)

References


MULTIMEDIA

<table>
<thead>
<tr>
<th>Vendor</th>
<th>Product</th>
<th>Web Site</th>
<th>Category</th>
<th>License</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft</td>
<td>PowerPoint</td>
<td><a href="http://www.microsoft.com/downloads">www.microsoft.com/downloads</a></td>
<td>Presentation</td>
<td>Mac/Windows</td>
<td>$219 (as of Office 2007)</td>
</tr>
<tr>
<td>Sony</td>
<td>Acid</td>
<td><a href="http://www.sony.com">www.sony.com</a></td>
<td>Music/Video</td>
<td>Mac/Windows</td>
<td>$99.95</td>
</tr>
<tr>
<td>Apple</td>
<td>Final Cut Pro</td>
<td><a href="http://www.apple.com/finalcutpro">www.apple.com/finalcutpro</a></td>
<td>Video Production</td>
<td>Mac</td>
<td>$499</td>
</tr>
<tr>
<td>Sony</td>
<td>Vegas Pro</td>
<td><a href="http://www.sonycreative.com">www.sonycreative.com</a></td>
<td>Video Production</td>
<td>Mac</td>
<td>$1,499 (as of Office 2008)</td>
</tr>
<tr>
<td>Adobe</td>
<td>Photoshop CS4</td>
<td><a href="http://www.adobe.com/products/photoshop">www.adobe.com/products/photoshop</a></td>
<td>Design/Photo</td>
<td>Mac</td>
<td>$199</td>
</tr>
</tbody>
</table>

As the chart indicates, by specifying "academic pricing" with discount vendors, you can acquire many of these programs below list price.